Band, Mode, Filter Controls
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The Band, Mode and Filter buttons can appear differently according to the rig, the maximum and minimum frequency, the rig mode types and the
rig filter groups. Shown in the following sections are the K3 & KX3, K2, Yaesu, Kenwood and Orion variations. They all share the following
controls.
BANDS:
All bands have at least a three-deep bandstack. The GEN button has a five deep bandstack allowing users to cycle through a selection of broadcast
stations. The bandstack depth can be added to by editing the database; a document outlining the mthos is avialbale on the NaP3 website.
A 2 button (144MHz) can be made to appear by setting the rig Maximum frequency (see Configure: NaP3/Frequencies) to 144.000000). Similarly,
if desired, a 6 button can be made to appear for rigs with a Max Frequency of 30Mhz.
FILTERS:
A click on these will change Nap3 and the rig. Otherwise, NaP3 follows the rig, any change of filtering at the rig losing the button selection, a return
to the preset values highlighting the button again. Change of mode will reveal changed filter values each of which can be easily modified, a right
click on the button showing a context menu thatl offers Configure and Reset to Defaults - see the next entry in Help Contents. Whatever your rig,
it is worth configuring the filters to values that you prefer. These new values will be saved in the database.
The K3 13kHz FM filter cannot be varied, and AM cannot exceed 8kHz unless 'CAT Polling/Filter Width' is unticked so that other bandwidths can
be set for the NaP3 sdr.
For the K3 the end button changes the rig filter group between I and II and for the KX3 it changes the filtering mode at the rig.
With Yaesu the end button will change between NAR on and off and the preset filter buttons will only work if values are within the ranges allowed
by the Yaesu mode and the NAR button setting. E.g.in NAR ssb, a NaP3 preset wider than 1.8kHz will not work.
In Kenwood the end button will be an extra VARiable filter.

Bandstacks
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There is a three-deep bandstack on all bands except 60m and GEN, which have five-deep bandstacks. The choice to stackf modes and/or filters on
each frequency is selectable in the Options tab.
On opening and running NaP3, it will go to the frequency, mode and filter that the rig is set to. A click on the Band button will store the
frequency, mode and filter (if the Options for the latter two is selected). A further click will go to bandstack entry two, another click to bandstack
entry three, and the next click will return to the first bandstack saved from the rig.
These can be varied to suit the operator's favourite frequencies, modes and filters, with the Span always returning to the chosen width for the
mode.

Collapse/Expand
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Clicking on Collapse will shrink the Expanded window below to a Collapsed window with separately saved height, width and top location - and
Controls. In conjunction with the settings in Configure NaP3/Options/Show Collapsed it will allow an operator to tailor the NaP3 Collapsed window
contents to requirements. In Collapsed mode these controls can also be accessed through the extra Controls menustrip entry. The Expanded window
can be recalled with Expand, which reveals all available controls again.

Expanded

Collapsed
NaP3 can independently resize and position the Collapsed and Expanded views, saving these views between sessions, in 96/120/144dpi.. The
minimum window height in Expanded is set to accommodate all the controls. A Collapsed view has a smaller minimum height but at low heights
increasing the number of controls visible will increase the minimum height downwards. A Collapsed display will not open overlapping the bottom of
the screen.
A Collapsed view with Band and Mode controls showing:

Colours
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The first tab, for Display colours is fairly self explanatory except for the Alpha sliders which increase the density of the chosen colours to make
them more visible.
Grid controls change the panadapter display graticule. V-Grid, V-Grid Fine and H-Grid allow the grid to be tailored to the operator's desired
aesthetics (the grid can be completely turned off in the Display tab).
Waterfall Palette choices may reveal extra colour buttons with some choices.
Cursor/Peak Readout changes the colours of the blue signal analysis figures in the bar immediately below the display.

Setup

Setup reveals a dropdown menu with four choices, explanations follow in order.
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Configure NaP3
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Each of the Configuration choices are tabbed. Many controls are in Groups, labelled and outlined. A description of each tab and its controls now follows.

Console View
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The Console view contains many components, each with its own characteristics and controls, described separately below.

DataText
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DataText is only visible on the menu if a K3 or KX3 is connected, offering a better view of the text from the internal CW/Data decoder.
It will only function in CW or a data mode. The window or TX and RX panels can be repositioned and resized - this is saved between sessions, as is
the font and its colour. The text output is only as good as the K3/KX3 decoder - so no CR or LF in RTTY for the time being, but a QSO with the
decoded text is possible.

The following true if window has focus:
Break in from keyboard on VOX or QSK, Ctrl+T transmits, Ctrl+R receives.
DataText 12 memories edit/test with Ctrl+M, F buttons also send with dialog closed.
DataText receive window call capture with left click on call, substitutes for $ character in memory string.

Display
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The groups outlined below control the appearance of the spectrum (panadapter) display.

In the Spectrum group, Spectrum Max is the signal level at the top of the display and Min the bottom, these can be set per band and are saved. For
bands where the noise floor varies, hovering a wheel mouse cursor over the console Avg button will allow the wheel to raise and lower these levels
in unison per band. Keeping the Ctrl key pressed while moving the wheel will reduce or increase the display range.
A similar control may be had with the Waterfall display and the Peak button. All these are saved.
Step is the interval between horizontal lines and Align sets the position of the scale in the grid.
Averaging Time is the period over which the panadapter display is averaged. Turn Avg off on the Console to get an idea of what zero averaging
does. Shorter periods update the spectrum display more often, making it more lively. At narrow spans and high fft numbers, a shorter averaging
time can make the display more responsive.
Show +-offset displays the panadapter either side of a zero centre frequency for rigs which cannot provide the information needed to feed the
display fully. Show Grid shows/hides the display calibration grid.
In the Refresh Rates group, Main Display FPS enables the setting of the display refresh rate. Higher rates can make the display smoother. Fill
Panadapter fills the area below the spectrum level display with a selectable colour and saturation, making it more visible.
Peak Text sets the refresh rate of the row of blue 'peak signal found in the display' numbers at the lower right of the display.
CPU Meter controls how often the CPU % figure in the console is updated.
Band Plan sets red band edge markers appropriate for the region you are in, e.g. USA Region 2, Europe Region 1 etc, or for
Broadcast bands.

Other DSP Settings
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The DSP tab has some other interesting and enigmatic settings which allow a certain amount of tailoring of the Main/Sub SDR
behaviour but the two NaP3 software receivers cannot be changed independently. Playing with them is instructive even if you return to
the default settings (you did note them down, didn't you?)

The groups on the left cover QRM/QRN control.
For Noise Reduction, NR: the greater the Taps the better the noise cancellation but signal processing time, i.e. latency, will increase.
Delay is the time taken to compute the NR filter and can corrupt speech as well as adding to latency. Gain increases the NR filter
build speed but makes it less stable.
Underneath is an extremely useful NR/ANF Position option to position the Notch and NR operations before the AGC take-off. Using
this, a loud adjacent carrier which is notched out will not push down the overall RX level with AGC action.
The AM/SAM demodulation has settings for the NaP3 receiver synchronous AM mode. If your Rig Type does not have a sync AM
mode button they will not apply.
Controls in the centre tailor the Noise Blanker thresholds while those on the right adjust the AGC characteristics.
The Window dropdown selects the 'fft windowing' function and this very rarely needs changing from Blkharris (Blackman-Harris) for
good filter skirts in the NaP3 dsp receivers. Those who have the setups to gauge the statistical advantages of signalling rates using
different 'windows' will know how to use this.

DSP
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The DSP tab contains several groups of controls. The top centre group in the DSP tab is for WBIR, or Wide Band Image Rejection. Any signal
images will be seen as identical 'mirror image' signals always symmetrically positioned either side of the display centre. These will
appear on all bands and as a signal tunes one way, the image will tune the other. If it does not look like that, it is not an image. Even
without WBIR, some image rejection should be obtained if the input audio channels have been balanced (see Sound Card).

Signals + Images
NB: If you do not have your audio levels fairly equal, or a mono signal, or the plugs/sockets make intermittent contact, you will have
images whatever you do. If you have not set the input level as described earlier (see Sound Card), the image rejection algorithm may
operate in less than optimum manner.

Because the only 'band' seen by NaP3 is the rig IF there is only one pair of correction values ever needed. They are always saved between sessions.
The pictures below enable options to optimise and/or lock these values into place.

Startup default

Manually set

Seeding

Auto

The first picture shows the setup default Manual setting with correction values of zero, and no image cancellation taking place.
'Old school' users may opt to remain in Manual, with the enabled Gain and Phase dropdowns offering the process of setting them manually. Each
of the values can be positive or negative and the DSP latency (processing delay) will cause the effect of any change to lag, especially when getting
close to the fine changes for optimum cancellation. These values will be true only for the image position in the display used to set them, but may
suffice much of the time across the display.

It is possible to speed up the process of acquiring values by Seeding with an S9+ signal, where an algorithm builds up values over about five
seconds, the values visible in the greyed out dropdowns. The S9+ signal can be from a generator or a single strong signal in a band, at least 30dB (5
S points) larger than any other in the band. When finished, WBIR will return to its previous setting with a new set of values. This can be carried out
at any time unless the signal is too too large, when a warning will appear. The values in the greyed-out dropdowns should change fast at first and
then slow as they converge on a good solution. If they dance about too much there are too many changing signals in the band.
Engagaing the WBIR Auto algorithm will use the seeded values to constantly improve upon them to cancel any image in the display.With Auto the
optimum solution is found for the distribution of signals within the band at any time (this is left running in the author's setup).
UNDER NO CIRCUMSTANCES ATTEMPT TO CANCEL IMAGES WITH YOUR SOUND CARD BALANCE CONTROLS. WBIR compensates
for small amplitude imbalances between channels and you will wind up 'chasing your tail' with poor image cancellation.

Macro Edit
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Below is the Macro Edit window. Each macro can theoretically accept up to 32767 characters and a terminating semicolon is already included in
the code. The names can accept up to about ten characters. The Hide button will reduce it to the command window again.
CAUTION: any connected serial port must be capable of passing the characters you have entered into the macro string. A direct rig connection will
be OK but the use of metacommands, such as K or AI with Elecraft equipment, can disrupt the interpretation of commands.

Equalisation
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Equaliser opens the Equaliser form with a three or ten band graphic equaliser. This controls both the Main and Sub SDR receiver equalisation
simultaneously. This does not affect a controlled rig.
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Sound Card

Leave the Setup dialog open and from the Menu RUN NaP3 in Expanded.
The Configure button allows the chosen device to be set up appropriately. For a sound card with separate input channels (rather than a stereo pair)
it runs the bargraph balance meter at the bottom of the tab. The card input controls should be set so that the centre green LED is lit most of the time
(OK, you can settle for a few either side!). A ~S9 signal source is best but it can be set with empty band noise.
With the FUNCube Dongle Pro Plus it will open a dialog to set appropriate values (see the FUNCube DP+ section below).
The Set Gain button will show a level control to adjust the display calibration with the card set externally for optimum performance. This ensures
that the incoming signals do not exceed the NaP3 headroom.

Balance shown at bottom

Level Control

Leave the Setup dialog open and RUN NaP3 in Expanded. Feed an S9 signal to your rig and set it to CW with ~600Hz bandwidth. A calibrated signal
source connected to your antenna (like the Elecraft XG2) is now (and later) really useful, but if your rig can locate any steady signal close to S9 on
your rig meter with any preamp switched in and no attenuator, tune it into the passband. Adjust the Level slider until the NaP3 S meter reads S9
(-73dBm). Do not worry about any other part of the display.

To set the noise floor on a band hover the mouse cursor above the Avg button and adjust the noise floor with the mouse wheel, for the Waterfall a
hover over Peak will act similarly. These will be saved per band, as will many other settings. More, much more, on this and other NaP3 functions
can be found in this Help file, but you should now be well set up to explore further. Information on many controls can be seen by hovering the
mouse cursor over the control. When this gets annoying just check Disable Tool Tips in the Options tab.
If your card has little inherent balance or you have problems with your connections you may see signal images. Images are identical mirror images
either side of the centre as shown in the first picture below. The second shows the display after the NaP3 image cancellation routine is set up as
described in the Menu/Configure/DSP section of this Help file.

If images persist, your sound card may still need to balance the left and right inputs correctly, or you are feeding a mono signal to both card inputs,
or a lead is not making a proper connection. You can wait for the automatic wideband image rejection to learn values for your hardware - a strong
broadcast signal in the passband will allow this. Or see the Menu/Configure/DSP section in this Help file for more information on other methods
of setting WBIR.
If the display 'tunes the wrong way' you have your inputs swapped. NaP3 expects the I signal in the Left channel and Q on the Right. A quick way to
change this is the IQ Swap checkbox in the Input tab.

FAQ
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1. What is the database?
It is an xml file of the rig type, selected options and closedown appearance of NaP3 that restores those closedown condition on the next startup.
It is kept in a normally hidden OS 'Users' folder. For Windows 7 this is Users/YOUR_A/C_NAME/AppData/Roaming/NaP3.
Sometimes there are changes in NaP3 that alter the default database structure and it needs a new default. This last happened after version 2.2.4.2.
2. Why can I can see signals I cannot hear or tune in to?
NaP3 only sees what it is fed. You may be seeing pickup on connecting or power leads, spurious signals from your rig or both. All this will be
worse if the fft number is set high. The big values are best for looking into narrow bands.
3. Why does it use a high % of my cpu?
You probably have a single core processor. No matter how fast, a single core will struggle with everything going on in NaP3 - the system it was
written on has an i7 processor. A USB sound card adds extra demand on the processor, as does enabling any of the NaP3 receiver controls.
4. Why does NaP3 usually need a sound card for its input?
This is the easiest, cheapest way to convert the analogue I/Q signal to digital for processing. It is inevitably a compromise.
5. Why am I having trouble with other programs that I have running in conjunction with NaP3?
This sometimes happens if a 'buffer' program such as LP Bridge is not used. Using that, the author can have a logger, CW Skimmer and two
instances of MMTTY running simultaneously. If NaP3 runs standalone on your system the interfacing of other software may need reassessing.
6. It does not work properly when I use it with "Magic DX SuperMagnet Professional" (or some other software package).
Does NaP3 work standalone with your rig? If it does, it is not a NaP3 problem.
7. Why won't it work for me?
Most often caused by a sound card driver being unhappy with the OS and/or incorrect hardware configuration. Check with the LP Pan Yahoo!
group for the experience of others with a similar configuration.
8. Why is there a spike in the middle of the display?
This is usually caused by poor sound card design or poor isolation at the sound card input. Good interfaces like LP-Pan have wideband isolation
transformers. The content of the spike is a mixture of stuff, from a 1/f component which is big towards dc (~0f) to ground loops.
Wide, flat displays with no spike are to be treasured above pearls but the 'DC Block' option in the Input tab should help some.
9. Why does the noise floor turn up/down at either end of the display?
Wide, flat displays are few. This is usually caused by limits to the sound card response. Using it for I/Q input is not the same as plain vanilla audio.
Possibly also caused by limited IF bandwidth in the connected rig.
10. Why am I having trouble with my "SuperMega mk16 192kHz HiFi Lo-Noise 8.1" laptop sound input?
Is it really a stereo input? Even if it is not a mono mic input, not all advertised sound card performance claims are true...
11. Why is the detail and refresh rate so good at narrow spans?
Because audio 'baseband ' is being processed, rather than sampling and processing the IF directly.
12. When will NaP3 serve cold beer and fries?
NaP3 is improved and rebuilt gradually, Perpetual Motion and FTL travel will come first.

Filter Configuring
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The window below left appears if a filter button is right clicked. If Configure is selected the window below right appears. The Modes are
presently still in the original PSDR format and need some translation - datamodes in particular needs care in selecting the correct sideband
(DIGU or DIGL). These will be recoded to rig modes in a forthcoming version.
Pick your mode, the filter, its high and low frequencies (take care with the sign, it is all -ve for lsb modes) and name it, close, and it will
appear in the row of filter buttons.
The default settings for narrow SSB are offset from the carrier frequency to maintain intelligibility. Data modes offer a range of filters from
3kHz for feeding audio digital software, to 50Hz for psk31.
Reset to Defaults is fairly obvious!
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FUNcube Dongle Pro Plus

For FUNcube Dongle Pro Plus users - IF to USB all in one small package that enumerates as a sound
card - the Configure dialog has extra settings, illustrated left.
The LNA Enable and Mixer Gain can be set as shown for good low noise performance but the IF Gain
is not needed. The FCDP+ needs DC Block set on the Input tab to mimimise the centre hump and the
Set Gain control adjusting appropriately. In the author's setup needed reducing by ~7dB compared to
the E-MU 1212m. The actual value in any setup will depend upon the total gain between the rig antenna
connector and the IF output. As with quality sound cards the channels are already close to balance by
default.

The FUNcube Dongle Pro Plus is particularly useful for those with an IF in the VHF region but can be used at almost any frequency.
There are a couple of snags: the 'dc hump' in the middle of the display may make manual image cancellation (see Menu/Configure/DSP)
necessary. The dynamic range of the Dongle is less than the LP-Pan but it takes large signals to observe this. If a FUNcube Dongle Pro Plus muts
connected to the system *before running NaP3* to appear in the Input/Device dropdown. It will appear first with internal defaults but a Reset
enters the settings needed for a K3 IF. Others will need to adjust this. All the settings are saved.

FUNcube DP+ dialog

FUNcube on 40m at night in Europe.

In the picture above right, When that 9+40 signal gets just a few dB higher, the FUNcube Dongle clips hard, filling the display with
intermodulation. A 10dB rig attenuator pushes this threshold a bit further away, but this device may not be suitable for some stations; transmitters
on adjacent bands should be well down by the time they emerge from the rig IF but very strong local signals can give trouble.
A 'DC Hump' will be evident but enabling DC Block will reduce it; the author's 'before and after' are shown below.

To avoid the 'dc hump' further the FUNcube Frequency can be offset 6kHz or so like the LP-Pan and the Global Offset in the Rig tab used to
compensate for this.
Tests have shown that the IF Gain does not improve the sensitivity and in a large signal environment it may be necessary to remove Mixer Gain.
With the above settings in the author's setup the Dongle has about 7dB more gain than an E-MU1212m card, compensated for by the new Set
Gain control.

General Colours

The first tab page under Colours offers the ability to change a few more colours. The labels are pretty self-evident.
If a completely dark background is required the 'Stealth' selection can be chosen.
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Input
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The Input Device group allows the input device to be selected. There are currently two options in the dropdown: most users will choose Sound
Card for the input device but the FUNcube Dongle Pro+ can also be used.

The Input tab, showing the 2 current choices
Whichever device is used the Sample Rate will show the available rates and should be set to the required maximum span. The viewed span can
easily be set later to anything down to 1kHz .
Swap IQ swaps around the I and Q input channels. The unwritten convention is for I to the Left channel, Q to the Right but this checkbox can save
resoldering a connector.

In the Sound Card group choose the Driver - for most users an MME driver is often favourite for sharing with other software, like CW Skimmer
or a logger. ASIO is a good low-latency driver but listening to the NaP3 output on the computer speakers will need a right click on the Console
RX gain controls. Now choose your Input, which should correspond with the card (or Dongle) being fed your I/Q signals. With MME the Output
can be left as the Microsoft Sound Mapper to hear the NaP3 receiver audio on the computer (Main to left, Sub to right if the Sub receiver is on,
otherwise Main through both).
Add Latency is an important setting to avoid choppy or stuttering sound; it needs to be of the order of 10ms for ASIO and 25ms for MME but will
vary from card to card and driver to driver. Latency is the time taken by the NaP3 DSP to process the signal, heard as a delay. A DC Block option
allows some reduction of any sound card centre spike but the results will vary with different cards. Sample Offset is needed for a few seriously
cheap cards which do not interleave the sound samples properly.
Set Gain opens a level control, described in the next section, to adjust the display calibration with the card set externally for optimum
performance. This ensures that the incoming signals do not exceed the NaP3 headroom.

Introducing NaP3

Top Next

NaP3 generates no signals of its own. What you see is what you feed it.
NaP3 is a spectrum display with some rig control and two sdrs aimed at rigs with an IF or I/Q output. It can be configured just as a panoramic
display, or used with its SDRs as extra receivers, or to provide tailored rig control functions.
The source code is extensively modified PowerSDR-IF and PowerSDR (copyright Flexradio Systems Inc).
It just needs a pair of quadrature signals, or I/Q. To get these the rig IF needs downconverting to baseband audio with hardware such as the excellent
LP Pan by N8LP ( www.telepostinc.com/LP-PAN.html) and then fed to a sound card. The FUNcube Dongle Pro Plus can also be used which can
convert VHF intermediate frequencies and has a USB connection. The Elecraft KX3, with its direct I/Q output can be directly connected to a sound
card
If your I/Q (audio) input pair are close to balance you should achieve up to 30dB of image rejection. NaP3 improves on this with a Wide Band
Image rejection routine that when optimised (see DSP/WBIR section) gives ~70dB of rejection.

40m at night in Europe with thunderstorm 100km away

Top: 13k wide RTTY span. Bottom: 4k wide PSK span.

NaP3 displays the result with a maximum display width determined by the card sampling rate. A 192kHz device should allow 192kHz to be viewed.
Lower sampling rates will generate smaller maximum spans but it is possible to zoom in from *any* maximum span down to 1kHz width, at any
sample rate. Narrowband modes can be studied more closely by increasing resolution with the FFT bin control.
Two sdr receivers are available but the Sub rx is an identical clone of the Main rx with its frequency determined by an offset from the Main rx
frequency. For the sub rx to function, this offset must remain within the maximum display span, which is defined by the main audio sample rate.
The rx passband width and position set at the rig are reflected in the display, with cw pitch also taken into account.
The entire display span can be recorded for later playback and during playback the sub rx can tune around the recorded spectrum.
Sixteen macros are available, and for K3 & KX3 owners, data decoder output. NaP3 will go into sleep and wake up with the computer and it will
display at 96, 120 and 144dpi (100, 125 and 150% in MS speak, also known as Smaller, Medium and Larger. Ha!).

K2 Controls
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Below is the K2 control panel. The Band buttons stop at 10m. The Mode buttons reflect the possible K2 modes with the addition of a SAM,
synchronous AM, mode for broadcast listening. The Filters can be preset (see Filter Configuring).

K3 and KX3Controls
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K3, KX3 Mode Buttons:
K3 and KX3 modes other than LSB & USB can be repeatedly clicked to set sub-modes like CW-R and AM-S. A right click on the AM-S button
show a context menu that allows upper or lower sideband AM-S. The data button changes the digimode with a left click and sets data normal or
reverse with a Ctrl+click.
The FM button will follow FM- and FM+ rig states but the TX offset will not be visible - unless within the displayed span.

The filters can be configured with a right click on the Filter buttons (see Filter Configuring) and there is an extra entry to choose either the I or II
group of K3/KX3 filters.

For the KX3 there is an extra context menu on the selected Band button to choose whether this is an 8kHz offset band or not. This is saved per band,
the same as the KX3 firmware.

Kenwood Controls
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Below is the plain vanilla, or Kenwood, appearance. One button per mode. The NaP3 display passband can be set from the filter preset
buttons (right click to set your preferred values) but this will not adjust the rig values. The Filters can be preset (see Filter Configuring).

Keyboard
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This tab allows keyboard shortcut keys to be set. They work only when Enable Shortcuts is selected in the Options/Keyboard tab.

Links

Useful places if you do not already know:
NaP3
Elecraft P3
PowerSDR-IF
N8LP LP Pan site
Yahoo! Groups LP Pan group
FlexRadio Systems
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Macro Commands
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Macro Commandss will reveal the macro control window shown on the left. It can contain sixteen named macros each
initiated by a click on the appropriate button.
The Edit button will open the editing window to define the macros.

Menu
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The Expanded menustrip appears above, the Collapsed below - which adds an entry. Various choices under each entry will be described
hierarchically, e.g. Menu/Setup/Configure NaP3/Input.

Mouse controls
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There are a lot of mouse functions available within the main Display:
· Positioning the cursor within the display while NaP3 has the focus will allow the mouse wheel to tune VFOA up or down in steps set by the Tuning Step
control (S Meter left upper). If the Sub RX is enabled the wheel will tune VFOB.
· A right click will reveal crosshairs and its position will make the blue figures at lower left display the level, the offset from VFOA and the frequency at the
crosshairs. A left click with the crosshair visible will shift VFOA to the frequency at the crosshair position. If the Sub RX is enabled, a second right click
will make red crosshairs appear and a left click will make VFOB jump to that frequency.
· Placing the cursor on the display with the left mouse button (no crosshairs showing) and holding a left click allows the whole display to be dragged hgher or
lower in frequency.
· A double click within the display will set the squelch threshold. This is not exact but a double click below a wanted signal will allow it through the squelch (if
turned on with the SQL: button). and above it will squelch the signal.
The mouse cursor will change appearance as it moves over the RX passband. With the MainRX, at either edge it appears as in the first picture below, and
between edges it appears like the second picture. The SubRX cursor always appears as in the first picture.

In the first case, holding down the left button, dragging whichever edge is selected and letting go will reposition it. The result will change the NaP3 SDR
filtering. The same can be done for the hf edge of the filter.
In the second case, a hold and drag will move the entire RX filter, changing the SDR filtering correspondingly. This applies to the SubRX if the first cursor is
showing.
Any change to the MainRX will simultaneously change SubRX filtering since this is a software clone of the MainRX.
A click on the leftmost/rightmost edge of the display in Fixed mode tuning (see Span Controls) will move the displayed span down/up one displayed span width
(the orange number at the bottom of the display) until the move exceeds the available maximum span.
Last, there are the Spot labels. If these are showing, a left click on any of them will snap VFOA to that frequency. It can get cluttered during a contest or opening,
so there is a label 'Stack Depth' which can be set in the Spot Telnet window (see Spots).

Multimeter

Previous Top Next

The right hand side of the Display tab contains settings affecting a mixture of controls.
Scope Mode sets the length of time for the sample shown when the display mode is set to Scope. The scope signal maximum is limited by the agc
action, so it is not an accurate picture of an incoming signal dynamic range unless AGC is set to Fixd and the RF: control adjusted.
The Multimeter dropdown boxes set various times for the meter dynamics.
Show Decimal puts a decimal point in the dBm meter readout for the seriously obsessive and Use Rig Value uses the rig S meter value sent via
CAT for those rigs, principally Elecraft and Yaesu, that have this function.

Options
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The Options tab contains a motley group of selections. Most have tooltips associated with them if the cursor is hovered over the selection. Under
Miscellaneous it is possible to turn off the tooltips if these become inconvenient once the user is familiar with NaP3.

The Show Collapsed group allows the Collapsed configuration to be tailored to the operator's requirements. These are arranged in rows which
can be selected to appear in Collapsed mode.
The Keyboard group has two settings; Enable Shortcuts (see the Keyboard tab to set these) and Quick QSY which enables the op to enter a
frequency whereupon NaP3 will jump that when the Enter key is pressed. These will only work if NaP3 has the focus and can be a nuisance if an
automatic focus grabber is working in the background. The author prefers to disable these because all these functions can be carried out easily
with a wheel mouse.
The group at lower right will appear as RTTY Tone Pairs and with some rigs, e.g. K3, should be set to match the rig setting. On other rigs it will
show updown boxes to select the DIGL and DIGU mode Clicktune Offsets which should coincide with the centre frequency of the desired mode.

Orion Controls
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Below are the Orion controls; the Band buttons stop at 10m. As with other rigs, the filters can be configured to the preset values wanted by the
user (See Filter Configuring)

Preamp Response
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The response of the display to switching on the rig preamplifier or attenuator may be puzzling at first because it is not intuitive. NaP3
compensates for the published preamp gain(s) and attenuator loss(es) of the connected rig. This keeps the display calibration correct, a signal
remaining at the same level whatever the post-antenna-connector settings may be. The first picture below is of an (XG2) -73dBm signal with no
preamp or attenuator.

Switching on a preamp (in this case the K3, +11dB) does not increase the displayed noise floor - it *decreases* it by the amount of gain to keep
the signal level correct:

Switching off the preamp and switching on the attenuator (K3, -10dB) raises the displayed noise floor by the amount of loss to keep the
calibration constant:

These responses can be useful when monitoring band conditions. For example, on a high band, if the noise floor does not drop when you add
preamp gain, the sensitivity has not increased - so you don't really need it! Best dynamic range can be retained by leaving it off.
Similarly, on a low band, if the noise floor does not rise when you add attenuator loss, your minimum detectable signal is limited by the external
noise floor and the attenuator can be left on to maximise dynamic range. In this way, with a directional antenna, it is possible to build up an idea
of the noise 'map' around the QTH. At the author's QTH the preamp sometimes improves sensitivity on 40m in one direction but not the other.

Basic Setup
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If you are a first time user, you will find there are lots of features in NaP3 that are explained in this Help file. You can choose among these once
you have the program running with the core settings.
When you run NaP3 for the first time - not an update - the windows below will appear on your desktop for a minute or so while a 'wisdom'
generation routine is run.

The 'wisdom' routine is storing some frequently-used math routine results which are used as a reference to make the program run faster. The
windows will never appear again unless you delete 'wisdom', which is stored in a hidden User file whose location depends upon your OS.
For Windows 7 this is "C:\Users\your_user_name\AppData\Roaming\NaP3". This location is also used to store a database with your settings.
With the CAT connected via the appropriate hardware and leads, and NaP3 opened but not yet RUNning, go to Configure and a tabbed Setup dialog
will appear, partly shown below. In the Rig tab select your Rig Type, in the Rig Serial Connection group choose the COM Port connected to the rig,
and in Baud the connection speed. For most rigs the other entries will now auto-fill but you may come back to fine tune some later.

Now click on RUN in the NaP3 menu and, if you have a rig connected and decent signals at your card input, some form of display may appear, but
the exact display does not matter at this point. Your rig should now tune the NaP3 VFOs, confirming that the CAT connection is working..
You can now STOP NaP3 and continue in the Menu/Configure/Input sections of this Help file according to your input device. For some rigs you
may also need to enter some settings in the Menu/Configure/Rig section.

Record
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Record opens a window that allows recording of the entire span for later playback and tune around. The controls are self evident apart from the
Add which allows files to be chosen for playback.
In Span Playback, the entire band will be visible and the vfo locked but the sub rx can be used to tune around the recording! Modes and filters
may be changed during playback.
Warning: recordings are made at the sample rate selected in Sound Card Setup and they can rapidly get very large, 100MB being needed for a
minute at 192kHz. An entire 24h CW contest would take about 144GB...
All files are saved to NaP3 Recordings in the My Documents folder. Recording the audio outputs of each sdr is in the next section.

Required environment
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At the time of writing (March 2014), NaP3 runs well under XP, Windows 7 and Windows 8 (depending on how Win8 is set up) but the 64-bit
operating versions can be sensitive to the audio driver and may need limiting to 4GB memory. NaP3 was developed with an E-MU 1212m PCIe
with the 2.30 driver, first on XP 32 bit, then Windows 7 32-bit and now a Windows 7 64-bit.
Just because card is described as "high dynamic range, low noise, 192kHz sampling rate" in the sales blurb does not mean it will meet an acceptable
standard for use as an analogue to digital converter of an input I/Q pair. With all operating systems most problems can be traced to the sound card,
its drivers and setup. This is a common result of using sound cards at the extremes of their specifications. Some have a high output level, bringing
NaP3 closer to overload.
LP Pan is the recommended interface for rigs with an IF output, having a wide dynamic range, high sensitivity and leaving no 'dc hump' at the display
centre. To obtain the best display sensitivity with some rigs an IF amp may be necessary.
The FUNcube Dongle Pro Plus has a lesser dynamic range but the advantage of transforming any IF, including VHF up to >2GHz, straight to a USB
I/Q input. It can also be used as a wide frequency range receiver with any computer and general-purpose SDR software.
If you already have an I/Q signal source - like the KX3 - just feed it to your NaP3 sound card.
A serial connection is needed for NaP3 and the rig to 'talk' to one another. If the port is shared with other software, LP-Bridge or LPB2 are
recommended to avoid the problems that can occur with less careful COM designs.
The quality of a sound card and its drivers are a significant factor in the overall performance. A mono-only input will not work. The best
information for LP-Pan sound interfacing is at www.telepostinc.com/sound cards.html.
The video card does not have to be too highly specified; the author uses a Radeon 4350 with two dvi outputs to drive a pair of 24” monitors, The
computer will ideally have a multi-core processor. A good cpu will allow a couple of instances of NaP3 to simultaneously run comfortably, with a
logger, CW Skimmer, a couple of instances of MMTTY, a browser and email. With a four-core cpu the processor utilisation can run as low as 4%,
but a USB sound card or the use of any DSP functions will increase this. A wheel mouse is essential for the full enjoyment of NaP3 capabilities.

Rig differences
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This software has been extensively tested with the Elecraft K3, the Yaesu FT950 and the TenTec Orion. Other rigs have not been fully tested but the
FT5k and FT3k are also known to work.
The appearance of NaP3, especially the mode buttons and behaviour, will vary between rig types. Each rig's user interface behaves differently;
reflecting this in the NaP3 gui can be fraught. For differences in appearance see the Console View subsection Band, Mode Filter Controls.
The Kenwood rig definitions are basic. Within the range of Kenwood rigs the CAT shift/width information needed for NaP3 to auto-set the
passband display is mixed between commands, modes and models so coding for these is not straightforward. Filter centre frequencies that change
with high and low cut settings, makes obtaining complete filter information difficult.
For most rigs the NaP3 built-in sdr (and thus display) passband can be set from the filter preset buttons (right click to set your preferred values).
These will also set the rig if it can accommodate the values - this will not adjust Kenwood rig values.
Some rigs will need IF Offset values set in the Rig tab; other users are the most up-to-date source for these at the moment. Without a Kenwood rig
avaialble, the following values were found by feeding a K3 with 'Kenwood TS-940S' selected:
The CW passband will be centred on the 'CW Pitch' setting in the Options tab if, in the 'IF Frequencies' tab, CWL is set to the CW Pitch and CWU
is set to -CW Pitch (i.e. -ve).
The DIGL/U passbands will use the values from 'RTTY Tone Pairs' in the Options tab if, in the 'IF Frequencies' tab, FSKL and FSKU are set to:
915/1085 tones
775 and 1945
1275/1445 “
1125 and 1585
1445/1615 “
1305 and 1415
2125/2295 “
1985 and 725
Crosshair tuning also works for CW and FSK set in this way.

Rig
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The Rig Type setting allows a wide range of rigs to be connected - the available and default settings will vary with the rig. The Rig Serial
Connection should be the port the rig is connected to or a virtual port on appropriate software like LP-Bridge or com0com. Set the Baud rate to
as high as your rig can take, data, stop and parity are internally set by the Rig Type. If the CAT connection is unwanted, there is an OFF setting
which disconnects NaP3 from the rig.

CAT Polling can enables/disables polled data used by the selected rig type, autocompleted for these rigs. This display may disappear in future
releases.
IF Frequency Offsets may need to be applied to position the displayed passband correctly where the information is not easily read from CAT
information.
Global Offset is used to set any needed difference between the rig IF frequency and the display centre. For example, the LP-Pan needs an offset of
about 6kHz, the KX3 sometimes needs an offset of 8kHz and The FUNcube Dongle Pro+ needs an offset to move the dc hump out of the way.
Frequency Limits areauto set by the rig type but may be changed, higher limits revealing 6m and 2m band buttons. For a K3 with the K144 option
the Maximum needs to be set to 146 or 148 according to local bandplan.
For rigs such as the K3 and K2 which swap the local oscillator injection 'side', the necessary IQ swap frequency is internally set within the Rig
Type definition.
Rig Timing controls a number of delays in the main polling loop. The Polling Interval can usually be safely reduced to 200msec to improve
responsiveness, otherwise these should rarely need to change.

RUN/STOP
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Self explanatory: clicking RUN will make NaP3 start running, the text changing to STOP. Another click will make it stop and it waits to RUN
again.
In STOP, NaP3 remains loaded but no threads are running. The program will sleep in either mode.

Receive Audio
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The RX Audio quick Record and playback are to a single file which is over recorded each time. The sdr Main and Sub rx, if enabled, go to the left
and right channels. A dropdown allows selection of the sampling rate to reduce file size, 6kHz being ample for simultaneous main and sub receiver
outputs with amateur signals.
All files are saved to NaP3 Recordings in the My Documents folder.

SDR Controls
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The SDR controls affect only the NaP3 Main/Sub sdr receivers. Enabling them will increase the cpu load. Some of their settings may
be tailored in the Configure: NaP3/DSP tab.

From left to right:
MUT mutes both Main and Sub sdr receivers. They are automatically muted on transmit, the MUT button retaining the rx setting.
RX EQ enables/disables Equalisation on both Main and Sub.
MAIN and SUB control the audio on each receiver (SUB needs enabling for this to work!). A right click on either will offer the option to enable
VAC, which also allows sdr audio monitoringthrough the system with ASIO drivers,
RF is a pseudo-RF gain control that sets the AGC loop gain.
SQL turns on squelch, also auto-enabled by going into FM mode, activating the Squelch slider. The SQL button shows the squelch level, saved
independently for FM.
CPU % reveals the processor load. It increases with more sdr functions selected. The figure shown is a typical average on the author's system
(2.67Ghz i7) with ASIO 'listen through'. The more cores, the better!
AGC selects the attack, decay and hang preset that suits you.
BIN is binaural output, giving a spatial impression with a signal.
NB is the noise blanker which will also reduce displayed impulse noise (takes out the electric fence to the west!).
NB2 uses another blanking algorithm to counter noises.
NR is noise reduction, which works best on a coherent signal like cw.
ANF is the automatic notch filter.
These can be set to operate before AGC action by selecting Pre-AGC in the DSP tab. Really useful!

Show Buttons
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Before Show Buttons is clicked in the XVTRs form, the band buttons will typically look like this:

The actual appearance will depend on the capability of the connected rig and/or the maximum frequency settings in the
Configure/NaP3/Frequencies tab.
After clicking on Show Buttons the VHF buttons will appear. Those shown here are unconfigured in the XVTRs option:

After configuring they might typically appear like this:

Span + Tuning Controls
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As a result of the coding, NaP3 has an extra option for tuning a band. Free changes to Fixed when clicked; in Free the spectrum moves under the
passband while tuning - see the picture below. Fixed holds the span while the passband tunes across it. If the Span is reduced from the maximum, a
right click on the Fixed button when enabled will reveal a choice of incrementing the Span 'window' across the maximum available in Whole Span
or Half Span jumps. The picture below shows a slice of 40m in Fixed tuning with VFOA tuned low, displaying the band beyond the maximum valid
display as a greyed-out 'hyperspace' (actually the out of sight, lower edge wrapping around again). If VFOA carries on tuning low, the Sub rx
frequency will pass into the greyed area, muting the NaP3 sub rx while it is in there.

In Fixed or Free, a left click on Centre will return the VFOA frequency to the centre of the display. For the context menu from a right click on
Center, see the next topic.
The slider between these buttons adjusts the displayed span width, the actual width being shown in the orange figures below the display centre; it
can also be adjusted with the mouse wheel by hovering the cursor, or right clicked to jump straight to a selected position.
It is saved per group of modes: in SSB, CW, AM, FM for all rigs plus: the 4 data modes for the K3 and KX3, RTTY for the K2, RTTY, PKT,
PKTFM for Yaesu, DIGL, DIGU for Kenwood, FSK for the Orion
By left clicking and holding on the spectrum it can be dragged to where the user wants. In Free tuning mode the spectrum moves under the fixed
VFO. In Fixed tuning the 'dragged' spectrum remains fixed, moving the VFO to maintain the same relative position in the fixed span. In both
cases VFOB remains on the frequency it is set at.

Span presets
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NaP3 has a powerful feature which enables the display characteristics of each mode on each band to be saved. For example a 5kHz span set for
high FFT number PSK might be needed, then a 192kHz view in SSB with a low FFT number, then a 2kHz slice of a beacon sub-band at maximum
FFT to montior the waterfall. Each of these is almost instantly available by setting the context menu shown with a right click on the Center button:

'Save Span Preset', will save all the current span settings for the mode, including Span width, FFT size, wheel tune step size, and Fixed/Free
tuning. With the bandstack already saving VFO frequency, mode and filter, the combination allows a user to return to a frequency with the same
filter, mode, span width, FFT size, tuning step and tuning style that they last saved.
So, for example. a user can save a 7.01 MHz centre in CW displaying a 20kHz width with a 10Hz wheeltune step, 16384 fft resolution in Fixed
tuning. And then save a 7.16 centre in SSB, displaying a 192kHz width with a 100Hz wheeltune step, 4096 resolution in Free tuning. And so on.
The mode groups (e.g. LSB/USB and CWL/CWU are shared as "SSB" and "CW") varies according to the rig, but a span preset can be saved for
each mode on each band.
With 'Restore Span Preset' it is possible to go straight to a centre of interest on any band.
If you do not like the preset it can be deleted with 'Delete Span Preset'.
And if you always want to go straight to your centre of interest in a mode on any band, 'Always Restore' will override your rig VFO frequency to
place you right in the action.

Spectrum Readings
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The row of blue figures immediately below the main display are useful tools:
The group on the left will only appear if the cursor is over the display. They show the cursor displacement from VFOA, the signal level at the
cursor and the absolute frequency at the cursor. If the cursor is hovering over the waterfall the second figure will instead show the time elapsed to
reach that position.
The group on the right are for the largest signal currently with the displayed span, its displacement from VFOA, its level and its absolute
frequency.
The middle orange figure is the current width of the displayed frequency span. It varies with the span slider, and the setting is saved per mode for
each of ssb, cw, am, fm and digimodes. Left clicking on the orange figures will put a horizontal marker line in the waterfall if Waterfall Markers
is enabled in the Options tab.

Spots
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Spots will open a telnet window like this, shown as just logged in to GB7BAA:

To respond to the login sequence you will need to set your call in the YOU! button. A right click on the buttons will bring up the button editor:

You can edit these to taste but Button 10 text (long box) will always be sent in response to login: or call: or similar sequences from the spot server.
Button 10 label does not have to be YOU! it can be anything.
Choose a server in the 'Cluster:' combobox and a click on CONN will now log you on, unless the server has a less common sequence. Any extra
text can be typed in the 'Type:' box from now on.
A right click in the telnet window will show the context menu you can see in the first picture. This has six options:
Hide Spots which will toggle hide/show spots in the span display.
Autostart will attempt to log you on as soon as you click Spots in the menu.
Spot Timeout is the usual timeout for how long spots should remain visible. Setting zero will clear the spots as in clear them, not hide them.
Stack Depth is how many spot labels deep should show on the display to reduce overlaps. On a quiet day this does not need to be large. In CW
WPX it needs a large number and a wide display!
Edit Cluster List if there are not enough in the combo box...
Change Font does something.
Once set up and running you will see something like this in the display (part of CW WPX 2014).

Click on any spot label to jump to the spot frequency.

The Display
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Below is shown a SpanaFall display split between Spanadapter and Waterfall. These, plus Scope, Spectrum (audio) and Histogram of the
received signal can be displayed individually and a SpanaScope combination is available. Some transmit signal can be visible but its magnitude
depends upon TX IF leakage in the rig.

The scale to the left is true for steady, constant amplitude signals, i.e. RTTY, PSK. The display is averaged (averaging time set in the Display tab)
so that the amplitude of a varying signal (i.e. CW, SSB) is duty-cycle-dependent.
The red line is the VFOA frequency (you can change the colour). The sub RX is enabled and VFOB is in blue The lighter stripe left of the VFO
lines is the passband (as you can see, LSB here), which will almost always coincide with the rig passband - in some modes and filter settings it is
possible for the SDR bandwidth to exceed the rig bandwidth.
The full height yellow line at the right is the result of enabling by a right click, when the mouse can position the line and its dummy passband
anywhere in the display, moving VFOA to that frequency with a left click. A second right click will display a red line and dummy passband for the
sub RX and a left click moves VFOB to that frequency.
The passbands can be made more or less visible with the Alpha sliders in the Colours tab
For most rig types the passband is positioned over the carrier (VFOA) frequency in CW and Data modes, generating the selected CW pitch and
RTTY tones. Swapping between CW and CW reverse will not reposition the passband, leaving the pitch the same (subject to calibration error) but
changing the tuning sense of the CW Pitch.
The sub RX cannot function past the edges of the full span width so if the VFOB is too far away the NaP3 sub RX is muted, while VFOB continues
tuning.
The passband will respond to the width and shift settings with the K3, KX3, Yaesu and Orion rigs. While the width responds smoothly, the shift
may cause the signal to 'warble' and display hysteresis briefly while moving, especially at high FFT Size settings. In practice this is only
disconcerting if the resolution is high for narrow band (RTTY, PSK, CW) signals in narrow passbands, in which case shift is of limited use.
The ability of the display to respond to rig shift and width will depend upon the rig. Full control is available with the K3 & KX3 but owing to CAT
limitations, only partial control is available with some Yaesu and very little with Kenwood.
When rig RIT and/or XIT, or SPLIT are enabled, vertical yellow lines mark the edges of the potential transmit passband as a warning. They always
show the transmit frequency edges or carrier (ssb shown but works in other modes too) and provide a heads up display of when RIT or XIT are
activated. If you do not like or need this it can be disabled in the right click context menu on the SPLIT button.

Top Controls

Previous Top Next

The Top Controls include the VFO boxes each of whose digits can be individually changed up or down with a mouse wheel. The group to the right
holds the meter, whose appearance and dynamics can be changed with the pair of dropdowns on the right hand side. The meter reads the true RMS
power in dBm of the current signal within the passband within 0.1dB.

The two controls to the left of the meter are, at the top, the mouse wheel tuning step size and under that the number of fft bins of the display. Each
of these is remembered per mode.
Useful tuning NaP3 step selections might be 5kHz for AM, 12.5kHz for FM, 100Hz for LSB/USB and 5Hz for RTTY/PSK. This does not set the
rig tuning rate - but tuning via NaP3 makes the rig follow.
The higher the FFT setting, the greater the potential resolution of the display Typical settings might be 4096 for wide span AM or LSB/USB but
65536 for RTTY or PSK. 16384 is good for most use, Higher fft numbers are most use at narrow spans - but the response will become slower at
higher values, so a reduction in spectrum averaging time may be useful.
Calibration of the display level will be retained for different FFT bin numbers, but the higher the number the more the displayed noise floor will
drop - even showing signals you cannot hear, including stuff picked up from the computer and cabling. Remember: NaP3 only displays what it
is fed.

VAC

Previous Top Next

The VAC tab is there because some users asked for it. It can also be enabled with the option revealed by a right click on either RX gain control.
VAC uses a paid software interface. Those that need it will know how to use it; the author finds it bizarre and prefers the use of a separate card.

VFO + Display Controls
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In the group of VFO Controls outlined in red below, those on the right (SPLIT to 0 Beat) are only visible in Collapsed if they are selected in the
menu under Controls, or in Configure NaP3/Options/Show Collapsed.

The SUB button turns on the SDR SubRX, using the the VFOB frequency, simultaneously on the K3 and some other rigs' SubRX. The KX3 is put
into Dual Watch. A right click on the SUB button reveals a ThirdRX option, which allows the SDRSubRX to be tuned independently - allowing
SO3R operation!
The four other VFO controls work on both the SDR and the controlled rig, 0 Beat netting VFOA with a CW signal within the passband.
The next group of controls control how the display is shown:

The centre drop down sets the display mode, with Scope and Histogram showing the RX signal within the passband.
The Scope display should not be taken literally in normal use - the maximum level is constrained by the AGC. To get a truer indication of the
signal in the passband set the AGC to Fixd and adjust the AGC T: control to keep peaks within the display. In this setting, hours of amusement can
be had in SpanaScope watching an overdriven signal 'flat top' on the Scope while the resulting intermodulation spreads out to the sides in the
Spanadapter part of the display.
The Histogram display shows the power spectrum within the passband. More amusing fun to be had here watching signals peaking at 20dB higher
below 200Hz than in the intelligence-carrying part of the voice spectrum. Keeps whales entertained.
Avg turns the signal averaging on and off. Hovering the mouse cursor over it will allow the mouse wheel to move the Grid Max and Grid Min
levels up and down in unison. Using the mousewheel with the Ctrl key pressed changes the range between the values. These are all saved per band.
Peak holds on the maximum signal level in the span. Hovering the mouse cursor over this allows the mouse wheel to move the Waterfall High
and Waterfall Low levels. Using the mousewheel with the Ctrl key pressed also changes the range between these values. These are also saved per
band.
Hovering the cursor over Free allows the spectrum/waterfall proportions to be varied in SpanaFall view.

Waterfall
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The Waterfall group sets the Low Level and High Level at which the waterfall display changes, or stops changing, colour. These can be set per
band and are saved. Similar to the panadapter display, by hovering the mouse cursor over the Peak button the mouse wheel can raise and lower the
waterfall thresholds in unison or, with the Ctrl key, increase/decrease the range.

Averaging Time selects how long the signal is sampled for the display. Shorter times will begin to show more signal detail but brief noise pulses
in the waterfall will begin to appear.
Update Period is the time taken for each 'step' in the flow of the waterfall.
For the range of Waterfall palettes available see the Colours/Display tab.

Transverters
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Clicking on Tranverters will open the transverter configuration form.
1. It allows the enabling of a VHF Band button,
2. Assigning it to a position in the row of VHF buttons,
3. Labelling the button text,
4. Choosing the LO Offset – e.g. 116MHz for a 144 transverter with 28MHz IF,
5. Compensating for the transverter LO error,
6. Choosing the start frequency and end frequency – e.g. 28 to 30MHz,
7. Compensation for the transverter gain:

Show Buttons allows the transverter band buttons to be shown/hidden and Swap I/Q Channels compensates for high/low side transverter local
oscillator injection. The automatic IQ swap for the K3 and K2 is disabled at displayed VFO frequencies above 68MHz and 39MHz respectively

Yaesu Controls
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Below is how the Yaesu Band, Mode, Filter row appears. Repeated clicks change to alternate mode configuration, e.g. RTTY-U or
CWR. If the filter does not correspond with one of the preset buttons, the VAR button highlights.

The Yaesu NAR filters may be selected with a right click on the currently set Filter button, bottom entry:

For the other entries see Filter Configuring.

